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PC-BSD Quick Guide

This quick start guide is aimed at users new to PC-BSD, FreeBSD and Unix in general. It is under constant development, and you
will probably find mistakes in this guide. Whenever you find errors, feel free to report them on the documentation forum. For the
latest and most up-to-date version please visit the Quick Guide online. Alternatively you can also download this file as PDF. We
hope this guide is both simple and useful and make using PC-BSD an enjoyable experience. If you have suggestions for PC-BSD,
you can either let us know on the forum, or send us an e-mail to: suggestions@pcbsd.org , we value your opinion. Thank you for
your support.
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1 Introduction

Thank you for taking the time to read this quick guide! In this first
chapter we will tell you about the philosophy of our operating
system, what PC-BSD can do for you, and what makes PC-BSD
so special. Then you will find out PC-BSD's cutting-edge features
and discover the result of a combination of FreeBSD, a
high-performance server operating-system with K Desktop
Environment (KDE) and desktop utilities.

You will still probably have some doubts, or require some help to
tweak your system; we'll tell you how you can solve your
problems quickly and easily. There is a thriving and friendly
support community, with a broad base of expertise, willing to
pitch in and help 24/7.
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You'll see that PC-BSD's goal is to be as easy as possible so that
you can focus on your work and hobbies, rather than spending
your time configuring your system. We hope you both enjoy PC-BSD and reading this guide. We have enjoyed bringing it to you.

Wishing you all success.

The PC-BSD team.

 

1.1 Welcome to PC-BSD

Welcome to PC-BSD and many thanks for your interest.

Early 2005 Kris Moore, the founder of PC-BSD, presented the first beta version of
PC-BSD to the community. What some FreeBSD advocates had been waiting for
for years had finally arrived: an easy-to-use FreeBSD-based operating system for
the desktop, with very little configuration necessary. A polished, full-featured,
free-of-charge, open-source operating system with a BSD license, based on FreeBSD, that anybody could use, from the beginner
to the advanced user alike, was a dream slowly being realised.

With the arrival of "easy-to-use" Linux distributions (another Unix-like operating system) and their immediate success, it became
obvious that there was a large niche market. However, Kris thought that the Linux market could have advanced more in user
friendliness. The BSD community had already very good server operating systems such as FreeBSD or OpenBSD, but none for the
desktop market. Taking a strong liking to FreeBSD due to its design, speed, and robustness, Kris Moore decided to create a
user-friendly and intuitive FreeBSD based operating systems for desktop use.

PC-BSD is a desktop-oriented operating system to the likes of Microsoft Windows XP or Apple Mac OS X. It is based on one of the
most powerful operating systems for servers, FreeBSD, a Unix-like server operating system which is based upon the BSD and Unix
operating systems, arguably the best of breed systems nowadays. When it comes to stability, scalability and openness Unix has no
competition. In fact Unix has been the undisputed choice of information technology professionals for many years. [Unix History
Chart | BSD History Chart]

PC-BSD started off as an independent project, but since 10 October 2006 PC-BSD is (financially) backed and supported by the
enterprise-class hardware solution provider iXsystems.

 

1.2 Differences between PC-BSD and FreeBSD

PC-BSD is essentially a customized installation of FreeBSD, and not a forked-derivative. PC-BSD is and will
always be based on FreeBSD's latest STABLE-branch. Since the underlying FreeBSD system has been kept
intact, you have a fully functional FreeBSD system under the hood that was built with speed and performance in
mind.

It is important to remember that PC-BSD is NOT a Linux distibution. Both FreeBSD and Linux are Unix-like
systems, but PC-BSD is based on FreeBSD and NOT on Linux.

The main difference between PC-BSD and FreeBSD is: PC-BSD is geared towards desktop use, while FreeBSD has been created
with server use in mind. Other differences are:

PC-BSD is based on FreeBSD (currently 6.3) and the KDE desktop environment (currently 3.5.8) [insert link to Chapter 5 - 
exploring PC-BSD]
PC-BSD is installed by a graphical installer, rather than FreeBSD’s text based installer (Sysinstall)
PC-BSD installs a bunch of pre-selected applications, whereas during a FreeBSD installation packages have to be manually
selected
PC-BSD supports all the major package management systems that FreeBSD comes with (PKG, Ports, source) but has also 
additionally developed the PBI package system (see Package Management)
PC-BSD’s kernel has been recompiled with some configuration tweaks to better suit it for desktop use
PC-BSD comes pre-configured with a number of automatic scripts (i.e. to mount [i.e. connect] digital cameras or USB 
memory sticks etc) that only work in KDE. So, if you want Gnome desktop environment instead of KDE, for the time being, 
you will have to install FreeBSD with Gnome or manually install Gnome onto PC-BSD. Be very careful when you install 
Gnome onto PC-BSD, since most, if not all, PC-BSD tools, which are KDE based, will not work. 

So, in summary, there is no real difference between PC-BSD and FreeBSD. PC-BSD is basically FreeBSD with a nice installer,
some pre-configuration, kernel tweaks, PBI package management, a couple pre-selected packages and some handy (GUI) utilities
to make PC-BSD suitable for desktop use.As a user of PC-BSD, you don’t have to worry about configuring your system, but rather
to simply install it and start working and/or playing with it.
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1.3 Microsoft Windows vs PC-BSD

As you may already know or will have gathered from the preceeding paragraphs, PC-BSD is a different kind of operating system
compared to Microsoft Windows. FreeBSD (the base of PC-BSD) has been built with stability and security in mind, and these
properties don't particulary spring in mind when thinking of Windows.

Let's have a look at some similarities and differences between PC-BSD and MS Windows.

Some similarities:

Both have a useful graphical user interface (though the command line is available in PC-BSD)
Both have a excellent internet connectivity stack (IPv4 and IPv6). Did you know Microsoft borrowed from FreeBSDs TCP/IP 
code?
Both have a large collection of applications available (currently 18.000+ for FreeBSD)
Both can browse and share Windows networking resources (SMB shares, printers)
Both can handle audio/video, can play CDs/DVDs and can be used for word processing, photo editing, databases etc
Installing software is easy, quick and straight forward

However, there are also some major differences:

PC-BSD is free of charge and its source code is free to view and to download
PC-BSD doesn't have a registry database where all the operating system's settings are stored, so your computer won't get 
slow after a few months' of use
PC-BSD is not affected by viruses, spyware and other malware that plague Windows systems
PC-BSD doesn't always have drivers or support for the latest or less popular hardware
Hard drives or partitions with PC-BSD installed don't need to be defragmented to increase the PC's speed

1.4 PC-BSD's goals

The PC-BSD Team aims to

make software installation as painless as possible and as easy as clicking a mouse button. To install software you simply 
double-click on a ready-to-use pre-built software package and the software will be installed without you having to worry 
about dependencies and other technical details. PBIs can be downloaded for free from www.pbidir.com.
create a minimalist operating system that is lean and fast. PC-BSD comes with a minimum of software installed so you can 
add only those packages you're interested in.
release versions that are backwardly compatible.

1.5 Reasons for using PC-BSD

PC-BSD has been designed with the "casual" computer user in mind. Installing the system is simply a matter of a few mouse clicks
and a few minutes for the installation process to finish. Hardware such as video, sound, network and other devices are
auto-detected and available at the first system startup. Home users will immediately feel comfortable with PC-BSD's KDE desktop
interface.

PC-BSD is a safe, secure and stable operating systems from the BSD family that is virtually immune to any virus infection. With
PC-BSD you can safely surf the internet without worrying about websites dropping trojans, virusses, adware or spyware on your
system without your consent. PC-BSD lets you run the best open-source applications, a number of Windows programs and (nearly
all) Linux software. This is all free.

PC-BSD's key features include all that a modern operating system has to offer. It combines the rock-solid stability, security and
speed of FreeBSD, the usability and functionality of the KDE desktop environment and the simplicity of PC-BSD's software package
management to provide a system that's easy to use and to install. Installing andremoving software has been made as easy as
clicking your mouse button and your system is kept up-to-date with automatic downloads. With PC-BSD it is now possible to
combine the strength of FreeBSD with the ease of use of Microsoft Windows in the same system.

With PC-BSD you can do about everything a desktop user expects from a modern operating system. Nearly all day-do-day
computer tasks and fun stuff can be done on PC-BSD:

Browse the web and send/receive emails
Chat with friends on Yahoo, MSN, AOL and IRC
Listen to mp3's, podcasts, streaming music/radio stations
Burn/rip CDs/DVDs and watch DVDs and videos
Use bittorrent and P2P networks for file sharing
Create drawings. Import, view and edit pictures and digital photo's
Play games and play online multi-player games
Write letters, create databases, spreadsheets and slide presentations, etc
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1.6 PC-BSD's most bleeding-edge features

Let's discover PC-BSD's unique features...

A) Visual system installer

Installing PC-BSD is a breeze! To install PC-BSD you only need to put the CD-ROM in the drive, reboot the system to start the
installer, select from menus, type in your information and click buttons to proceed step by step. PC-BSD does the hard stuff for you,
and only asks for the necessary information. The power user will find it interesting to access the advanced options to custom
partition the hard disk drive or access options such as DiskLabel. When you are done installing, just remove your CD-ROM, reboot
and you are up and running.

B) Fully graphical desktop environment

PC-BSD comes with the latest stable version of KDE award-winning desktop environment, and a few essential KDE applications
such as, Kate, Kaffeine, or Konqueror. KDE alone will probably cover most of your day-to-day needs immediately. [[LINK TO
EXPLORING PC-BSD]]]
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C) Graphical software installer

Installing software can hardly be easier than on PC-BSD. With a fully graphical software installer, you can install any .pbi file on
your computer the same way you are used to on MS Windows or on the Mac. Double-click the setup file, follow the instructions,
click "Next" and you're done! More...

D) Network Manager

Setting up your local network to access the Internet is easy with PC-BSD.
During installation, PC-BSD configures your connection using DHCP so that if you already have a connection to the Internet in your
home or office, you get connected automatically. You still have the ability to manually change your network settings such as IP
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address, gateway, netmask and DNS using the Network Manager.

E) System updates

Are you worried about having an outdated operating system? Don't fear! PC-BSD has a built-in system updater that will notify you of
available system updates to install security fixes, bug fixes, system enhancements and updated PBIs.

F) Visually attractive
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PC-BSD comes by default with Nvidia videocard drivers and the Compiz-Fusion accelerated 3D desktop for the next level desktop
experience. Also, Adobe Flash is installed so you can watch your favorite movies and videos on Youtube and Google Video out of
the proverbial box.

G) Optimised for i368s and compatible with the 64-bits architecture

PC-BSD is optimised for the latest systems for optimum speed and performance. PC-BSD is available for the i386 architecture and
for 64bits systems.

 

1.7 Package Management

As mentioned above, PC-BSD's package management system takes a different approach to installing software compared to many
other Unix-like operating systems. Instead of utilising FreeBSD's ports or packages system (although these are still available),
PC-BSD uses files with the .pbi (Push Button Installer or PC-BSD Installer) filename extension. All that is necessary to install a PBI
is to download it (e.g. from pbidir.com), double-click to launch the installation wizard program, enter the root password, follow the
installation steps and you're ready to use the program. Uninstalling is just as easy. Installing PC-BSD software packages (PBIs) is
similar to that of Microsoft Windows and Mac OS X. Installing PBIs is as easy as installing a Windows .exe file.

PC-BSD's own package management system resolves the issue of library dependency problems that often occur on Linux based
systems. This is the feature that sets PC-BSD apart from most free open source systems that are available. It's easy, simple and
straightforward.A PBI installs all software packages and libraries in their own self-contained directories in /Programs, decreasing
confusion about where the binary programs reside and reducing the possibility of breaking a package if system libraries are
upgraded or changed. The PC-BSD package manager also takes care of creating links in the KDE menu and on the KDE desktop.

 

1.8 Summary of PC-BSD's features

Fully functional and free operating system for the desktop; PC-BSD uses the popular KDE desktop environment
Based on FreeBSD 6.3, a stable, reliable and time-tested operating system in the Unix family
Improvement upon FreeBSD with extremely easy installation and greatly improved application management
All the major package management systems available that are supported by FreeBSD (PKG, ports etc), but has additionally 
the PBI package installer
Major Windows applications available for PC-BSD as PBI (OpenOffice, Firefox, Opera, VLC etc)
Major KDE applications are included in PC-BSD
Self-installing software packages (PBIs), making installing programs a snap
Graphical system installer, making the system installation process effortless
Graphical tools for system administration
Online upgrades and patches for PC-BSD and any installed PBIs are downloaded and installed automatically
Ability to read/edit/save Microsoft Word, Excel and Powerpoint files
Safe from viruses, adware, spyware and trojans that plague Windows systems
PC-BSD is able to run Windows XP/2000 through emulators (such as Qemu or Win4BSD) or Windows applications through 
Wine.
Adobe Flash 7 supported (Flash 9 available as part of the Win Firefox PBI )
Nvidia video card drivers and Compiz-Fusion 3D desktop pre-installed
Support for a number of native languages
Friendly and helpful support community
Professional email and phone support available from iXsystems 

 

1.9 More features (advanced/technical)

Based on FreeBSD, a Unix-like free operating system descended from AT&T Unix via the Berkeley Software Distribution 
(BSD) branch through the 386BSD and 4.4BSD operating systems
Licensed under BSD license (may contain many GPL, LGPL and other licensed software)
Optional SWAP space encryption (useful addition to notebook owners)
Powerfull PF firewall (Packet Filter from OpenBSD) automatically configured
RAM memory based and SWAP memory backed temporary drive space mounted as /tmp
Brute-force attack protection with denyhosts security application (IP of attacker is blocked for 20 minutes IP is unblocked in 
case you are blocked yourself)
Ability to run almost all GNU/Linux applications like Oracle, WordPerfect, Skype, Doom 3, Quake 4, etc. through to the Linux
Compatibility Layer (LCL). Generally, no noticeable performance penalty when running Linux binaries compared to native 
FreeBSD ones 
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1.10 PC-BSD Releases

PC-BSD 1.5 - 12 March 2008
PC-BSD 1.4.1.2 - 4 January 2007
PC-BSD 1.4.1.1 - 4 December 2007
PC-BSD 1.4.1 - 16 November 2007
PC-BSD 1.4 - 24 September 2007
PC-BSD 1.3.4 - 17 April 2007
PC-BSD 1.3.3 - 12 February 2007
PC-BSD 1.3.2 - 19 January 2007
PC-BSD 1.3 - 31 December 2006
PC-BSD 1.2 - 12 July 2006
PC-BSD 1.11 - 19 June 2006
PC-BSD 1.1 - 29 May 2006
PC-BSD 1.0 - 29 April 2006
PC-BSD 0.8.3 - 23 October 2005
PC-BSD 0.8.2 - 25 September 2005
PC-BSD 0.8.1 - 20 September 2005
PC-BSD 0.8 - 13 September 2005
PC-BSD 0.7.8 - 18 July 2005
PC-BSD 0.7.5 - 25 June 2005 

 

1.11 Where can I get help?

We are doing our best to make PC-BSD as easy as possible for newcomers. However, you will probably need help and we will
make sure your concerns are always addressed.

The knowledge database

You will find a fair amount of information in the PC-BSD Knowledge Database . You are welcome to add your hardware in the
supported or unsupported list of hardware too! If you think we can add more entries to this knowledge database, feel free to let us
know, and make this database richer!

IRC Channel

Yes, PC-BSD has an IRC channel! To get connected, use the following information:

If you don't know what IRC client to use, we suggest Kirc, Opera or X-Chat. You'll find a few IRC clients on the PBI Directory site!

Mailing lists

If you like community support by e-mail, you will want to subscribe to the mailing lists. Currently there are five mailing lists:

Announcements (Low traffic)
General
Support
Translations
Beta testing
PBI Developer
Documentation
Developers

Forums

You can find quick and specific help from the community on the forum if you weren't able to find a solution to your problem using
other means. If you want native language support, you may prefer to use other unofficial, PC-BSD forums. They are available in
Estonian, French, German, Polish, Portuguese, Russian, Slovak or Turkish. This is expanding all the time, so check availability for
your locale regularly!

 

1.12 Additional resources

Server: irc.freenode.net

Channel: #pcbsd
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PC-BSD is part of the BSD family of operating systems based on Unix, and is specifically based on FreeBSD. Since PC-BSD has a
fully functional FreeBSD system included, most adjustments that you do for FreeBSD also work for PC-BSD. As a result, the
majority of FreeBSD material will be useful for you as an advanced user. Here is a non-exhaustive list of other resources on
FreeBSD:

Forums

The BSD Forums
BSD Nexus
BSD Foren (German)
BSD Forums (Romanian)
BSD Support
Usenet channel - comp.unix.bsd.freebsd.misc

Search

Google BSD
The OpenDirectory
FreeBSD mail archives search

Portals and Blogs

The FreeBSD diary
O'Reilly's BSD Devcenter
Slashdot BSD
BSD Guru (Polish)
Freebsdlinks
Scott Robbins
BSD Guides

PC-BSD Community Sites 

PC-BSD Germany
PC-BSD Hungary
PC-BSD Poland
PC-BSD Russia
PC-BSD Spain
PC-BSD Ukraine

Miscellaneous

The FreeBSD Handbook
The FreeBSD FAQ
Dru Lavigne's tutorials
BSD Hacks (book)
Screaming Electron's tutorials
FreeBSD How-Tos for the Lazy and Hopeless
BSD Newsletter

2 Installation

Installing PC-BSD is straight-forward and very fast, taking no more than 20 minutes on a modern computer. In this chapter we will
explore the pre-requisites, things you should do before installing PC-BSD, and post-installation aspects.

After installation, we will discover how to connect to the Internet. If you have problems, we will also list the solutions to common
issues.

2.1 Hardware requirements

PC-BSD has moderate hardware requirements and commonly uses less resource than its commercial counterparts. To use
PC-BSD, the minimum recommended specification is:

An i686 CPU:
AMD Opteron
AMD Athlon
AMD Athlon XP
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AMD Athlon 64
AMD Athlon 64 X2
AMD Athlon FX
AMD Duron
AMD Sempron
AMD Turion 64
AMD Turion 64 X2
Intel Pentium Pro
Intel Pentium II
Intel Pentium III
Intel Celeron
Intel Xeon
Intel Pentium 4
Intel Pentium M
Intel Pentium D
Intel Pentium Extreme Edition
Intel Core
Intel Core 2

128MB RAM
4GB of free hard drive space (Either partition, or entire disk) for the desktop version; 8GB for the server version. 
CD-ROM Drive (6x or better)
Network card (optional, although some form of Network/Internet connection is strongly recommended)
Sound card (optional) 

However, it is advised to have 512MB of RAM if possible. If you want to play modern video games, you should use a fast CPU, and
if you want to create a collection of tunes and movies on your computer, you should use a larger hard disk drive too.

Most hardware should work with PC-BSD, but in some cases, cheap hardware has been reported not to work. If you use
mainstream or top-end hardware, such as those that feature VIA or NVIDIA chipsets, it will usually work flawlessly.

2.2 Creation of the CD-ROM 

You can either order a CD-ROM from PC-BSD Software, or download PC-BSD's CD-ROM image file from PC-BSD's web site. If this
is what you did, this section will assist you to burn PC-BSD onto a CD-R (Writable) or on a CD-RW (Rewritable). This tutorial
assumes you already have:

A CD-RW or DVD-RAM drive that allows you to burn media and not just read 
A writable medium in your DVD-RAM or CD-RW drive
A file with a .iso extension containing PC-BSD
A Windows or Unix computer to burn your ISO file.

At this point, you will have to choose how you want to burn your .iso file. If you use a Windows computer, you can choose from
Nero, Burnatonce, or CDBurnerXP. If you use a Unix computer with KDE (such as PC-BSD), you can use K3B. Alternatively, if you
use a Unix machine with Gnome, you can use Gnome Baker to burn your CD-ROM.

Burning the CD-ROM on Windows

Using Ahead Nero Burning ROM 

Ahead Nero Burning ROM is one of the most popular commercial applications on Windows to burn CD-ROMs and DVD-RAMs.
Although it is commercial, you usually have a month free to test it. Let's see how you can burn your CD-ROM in a few steps. Launch
Nero, and click "Recorder > Burn Image", select your .iso file and burn your CD-ROM. Alternatively, you can click "File > Open":
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In the Windows dialog box, select the penultimate option labeled "Image Files" to display .iso files in your file browser:

Browse to the directory where you stored your .iso file of PC-BSD; you should see your file listed. Select it and click "OK". On the
next screen, click "Burn", and Nero will start burning your disk:
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After a few minutes, Nero will alert you that the burning process is complete and will eject the CD-ROM for you.

Using Burnatonce

Burnatonce is a freeware application that you can use freely for your personal needs. It is a simple and light-weight application. To
use Burnatonce, simply launch it, and click "File > Load New Image...":

Your PCBSD .iso file will then be listed in grey in Burnatonce. Click "Write", and Burnatonce will start burning your CD-ROM:

A few minutes later, Burnatonce will let you know that the CD-ROM was burned successfully.

Using CDBurnerXP

CDBurnerXP is another freeware application for Windows. It has a modern interface and looks similar to its commercial
counterparts. Using CDBurnerXP is also very easy: Launch the application. A dialog window will appear and ask you whether you
want to continue burning files on a writable disk that already has files (multi session), or whether your CD-ROM doesn't have any
content yet (No multi session). You will click the second option "Don't Continue Disc (No Multi Session)":
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Afterwards, CDBurnerXP's main interface will show up. In the upper-left corner, click "File > Write Disc from ISO File...":

A dialog window then appears for you to select your .iso file. Under "Select an ISO image to write", click the "..." button to select
your file:
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The file will be listed in the main window. The only thing you have to do is "Write Disc", and CDBurnerXP will start burning your
.iso file onto your CD-ROM:
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Burning the CD-ROM on a Unix system

Using K3B on Unix-like installations with KDE X-Windows 

Any Unix-based operating system such as PC-BSD, FreeBSD or Linux distributions using KDE are suitted to K3B, one of the best
CD-ROM burning application for Unix. K3B has a similar interface to other modern burning software that you find on Windows, such
as Nero Burning ROM or Easy Media Creator. K3B is equally easy to use. Launch K3B and click "Tools > Burn CD Image...":

A new window will show up where you can choose your .iso file. Under "Image to burn", click the blue folder icon to select your file:
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Once your file is listed, click the "Start" button in the top-right corner, and K3B will burn the .iso file onto your CD-ROM.

Using Gnome Baker on Unix-like installations with Gnome X-Windows

Gnome Baker is probably the best CD-ROM/DVD burner for the Gnome desktop. It is also easy to use. To burn your .iso file, first,
launch Gnome Baker and click "Actions> Burn CD Image":
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A dialog window will be displayed and you will be able to select your .iso file. Select it and click "OK":
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The last window allows you to select your CD-ROM drive, as well as a few other options. Leave these options as default. Click
"Start" and Gnome Baker will begin to burn PC-BSD onto your CD-ROM drive:
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Gnome Baker will alert you when it is done burning your file after a few moments.

Now that you have a CD-ROM with the latest version of PC-BSD, let's go through installation!

 

2.3 Installation

Introduction

The PC-BSD installer has made installing a Unix-like operating system as easy as installing Microsoft Windows. When installing
PC-BSD you don’t need to use the command line or text-based installers, neither do you have to manually edit configuration files.

The installation of PC-BSD is a fast, easy and straight-forward process with a pretty looking Installer. An easy-to-use wizard will
take you step-by-step through the whole process by asking a few simple questions and after a few minutes you will have your
system up and running. Though the installation process has been made as short and as easy as possible, there are still some
advanced options available for power users.

Before installing PC-BSD on your computer, please make sure you meet the minimum requirements [INSERT LINK].

There are two options for installing PC-BSD:

PC-BSD taking the whole hard disk drive
PC-BSD installed on a partition of the hard disk drive with another operating system on another partition (dual boot, triple 
boot, multi boot)
What is disk partitioning?
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To start off, ensure you have backed up all your valuable data, especially if this is the first time you install PC-BSD and you have
saved data on another partition.

Be aware that BSD operating systems, and hence PC-BSD, only recognise primary partitions and consider any logical partitions as
a whole primary partition. Trying to install on a logical partition will convert your extended partition into a primary partition and erase
all logical partitions of your system. PC-BSD can be installed on any primary partition; it doesn't necessarily have to be on the first
one. Be careful and make sure you have a backup of your data.

Obtaining PC-BSD

PC-BSD installation CDs can be either downloaded or bought. If you have a slow download connection or if you want to support the
PC-BSD project financially, you can buy the CDs and/or support from iXsystems, the parent company of PC-BSD. Alternatively,
PC-BSD can be downloaded for free.

There are two PC-BSD installation CD’s. The first one is the system installation CD (required) and the second contains
multi-language support and the essential PBI Pack (optional). If you want PC-BSD in a language other than English (if available),
you will need to download CD #2 as well.

The Installation

Now, let's start the installation.

Ensure that your CD/DVD drive is configured in BIOS as a boot device and power on your computer. As soon as you can, put the
installation CD in the CD/DVD drive. After a while, a series of lines of code will scroll down the screen, meaning that PC-BSD is
being loaded.

If your computer didn't boot PC-BSD but rather loaded as usual, press the F8 or F12 key until you see a screen to select the drive
of your choice to boot. You may have to edit your BIOS or CMOS settings to change the boot order of all the bootable devices on
your system. When you get a screen to select which drive to select your drive of choice to boot, select the CD-ROM drive, based on
its hardware name, which should load PC-BSD immediately. Soon after, you should get a screen with the following options:

There are in total 9 options to choose from:

Boot PC-BSD [default] - Normal bootup, start with all standard options enabled.

Boot PC-BSD with ACPI disabled - This disables the ACPI device / power management, which may be useful for certain 
newer BIOS's and laptops [advanced]
Boot PC-BSD in Safe Mode - Boot up PC-BSD with a forced PIO mode (disabling the use of DMA) and disables write 
caching for all IDE hard drives and CD ROM drives, disables the probing of EISA slots (as very few systems have them),
and in i386 it also disables the use of ACPI and the APICs.
Boot PC-BSD in single user mode - Boot to a shell prompt right after the kernel is finished loading.

Boot PC-BSD with verbose logging - This option displays much, much more detail during the boot process.

Boot PC-BSD to emergency console - Boot to a PC-BSD emergency text console, which can provide access to the hard
drive, and allow fixing critical system failures.
Run installer in VESA mode - Disable trying to auto-detect the video card driver, and instead default to VESA mode.
Useful when option 1 fails to bring up the GUI installer.
Escape to loader prompt - Drop to the boot loader prompt to issue advanced commands, such as changing kernels, etc.

Reboot - Reboots PC-BSD ;-) 



PC-BSD Quick Guide file:///E:/Documents%20and%20Settings/Owner/Desktop/PC-BSD%20Q...

21 of 73 4/12/2008 2:23 PM

Option 1 ("Boot PC-BSD [default]") is recommended for most users; Simply hit "Enter" or "1" to start the installation.

Select Language

The next screen is the actual system installer with the first options:

As you can see, the installer is divided into four logical areas:

The left pane with the different steps of the installer, showing the current and completed steps with a different arrow;
The main area in the centre where the installer expects user input;
The quick tips at the bottom, always here to help you, to explain what each field means, and how to fill in the fields;
The bottom navigation bar where you can go forward or backward.

While at the initial pane, you must select your language, keyboard layout, and time zone. You can synchronise your clock with the
Internet if you want, or re-adjust your time manually for daylight savings, if needed in the future.

PC-BSD supports the BSDStats.org Project which collects different statistics and data (such as version, country and CPU) about
the use of different BSD flavours and the hardware they run on. By default the "allow submitting anonymous usage statistics" box is
checked. By leaving the checkbox ticked, PC-BSD will anonymously submit some data about your system to BSDstats.org. It's
recommended to keep this setting "on" so the growth and size of the BSD community can be measured. However, if this setting is
turned off at this stage and you change your mind later, you will have to manually install the bsdstats port
(/usr/ports/sysutils/bsdstats).

License Agreement

When done, click the "Next" button to proceed to the license agreement:
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This step requires you to accept the license agreement. PC-BSD is free and open-source software, based on the BSD license. You
need to accept that there is no warranty whatsoever in case of loss of data. PC-BSD comes with proprietary software such as
Nvidia video card drivers and Intel firmware. In order to use these you need to read the agreement and accept it in order to proceed
with the installation. By ticking the “I agree” box, you agree to all licenses.

Install or Update

Now you have to make a choice between doing a "Fresh installation" or a "System Update / Repair".

Select the first option, "Fresh installation", in the following cases:

You don't have PC-BSD installed on your computer yet, or
You already have PC-BSD on your computer installed but you want to reinstall it and erase all the content of the PC-BSD
partition

Select the second option, "System update / Repair", if PC-BSD is already installed on your PC, and
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you want to keep all your files and
you want to reinstall or upgrade to a newer version of PC-BSD

When you are done, click "Next" to go to the next step:

User Accounts 

In this step, an Administrator account (or "root" account) has to be created, as well as at least one user account. Similar to other
modern operating systems, PC-BSD has mainly two levels of administration:

Administrator-level: Full control over the entire system, can manage files, software and users (add/edit/remove);
User-level: Control limited to user's directory, cannot install applications system-wide, cannot edit files outside user directory

It’s good to be aware that the administrator has all system privileges and has access to all parts of the operating system. Using a
computer as an administrator can be dangerous because mistakes can have system-wide consequences, especially when using
the command-line.

To install software, for instance PBIs, the root password, so when you're installing a PBI and you're prompted for a password, enter
the root (administrator) password.

Using a computer as user is much more secure, and if damage is done, it will be limited to the user's directory. This is why at least
one user account needs to be created, which you will use to log into PC-BSD. Note, that it is not possible to log into PC-BSD as
administrator. When you have filled in the information for the new user, click the "Add" button, and the user account should appear
in the "User Accounts" field underneath. You can click a user name at any time and modify the details; clicking "Apply" will save the
changes.

You can leave the "Shell" field as it is. This option is used by power users who can choose which shell to use by default to interact
with the heart of the system using the terminal. The shell is to PC-BSD what MS-DOS was to MS Windows.

If you're security conscious or if you share the PC with others and you don't want others to access your files, unmark the
checkbox for auto-login.

Make sure you remember your user name (which is CaSe sensitive) as you won’t be able to choose from a list of user names when
you log on!

Click "Next" when the administrator account has been created and at least one user account has been added, to go to the next
step:

Drive Selection 
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This step allows you to select which physical hard disk drive and which partition are going to be used for the installation. The
"Detected Hard Drives" field lists the disks that PC-BSD has found during boot up, from which one needs to be selected. If you want
PC-BSD to use the entire disk, for instance if you don't have any other operating systems on your PC, and no separate partition is
used to store documents, you can check the "Use entire disk" option underneath to use all disk space of your hard disk drive.

PC-BSD doesn’t come with a built-in partition manager. If you’re planning to install PC-BSD on a partition, partitions have to be
created before installing. There is a quite a number of partition managers available, of which two, free, Live CDs are particularly
useful and user friendly: PartImage and PartedMagic. Before creating or editing any partitions, make sure you back up your
valuable data first.

In FreeBSD, and hence PC-BSD, each partition has a code in front of them, such as /dev/ad0s1, which is the path to the device
(dev) file. Naming convention is as follows:

ad0 or da0 means "first drive"
---s1 means "the first partition or "slice" in FreeBSD vocabulary

FreeBSD, starts counting disk drives from "0", and starts counting partitions from "1". Here are a few examples:

/dev/ad0s1 — First drive, first partition
/dev/ad1s1 — Second drive, first partition
/dev/da0s3 — First drive (SCSI), third partition
/dev/da1s1 — Second drive (SCSI), first partition

You also need to select the partition on which you want to install PC-BSD. If you already have more than one partition, all of them
will be listed under the "Partition Selection" box. Select the one you want to use.

If Microsoft Windows is already installed and if you wish to have PC-BSD on the same computer, check the "Install the PC-BSD
bootloader" option. The next time your computer boots up, a welcome screen will allow you to select which operating system you
want to use. If you wish to use only PC-BSD on your computer or if you already have a Unix-based operating system installed with a
bootloader such as Grub, GAG or Lilo, uncheck this option to keep your existing bootloader. When Windows is installed after
PC-BSD, the FreeBSD bootloader will be overwritten and PC-BSD will be unbootable, which can be easily fixed. More information
on the boot process, the FreeBSD bootloader and troubleshooting can be found here.

If you want to make a custom partition layout mark the corresponding checkbox (recommended for advanced users only).
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If you marked the checkbox for a custom partition layout, you may now edit the partition layout to your needs.

On the partition editing screen  the BSD disk partitions can be customised. PC-BSD (and FreeBSD) have two levels of partitioning:

Regular partitions, also known as "Slices" by FreeBSD (ie: C:, D:, etc...);
Sub-partitions invisibles by non-BSD systems, and known as "Partitions" by FreeBSD (ie: /boot, /var, /home, etc....)

You can keep all your mount points under "/", or you can spread them across several partitions or disks, or even across raid arrays
for maximum performance. At the very least, you need a "/" partition with enough room for your files (4GB+) and a SWAP partition
for virtual memory. Typically, SWAP space is advised to be set twice as big as your amount of RAM. This is not always necessary,
for instance if you have 1GB of RAM, 1 GB of SWAP is probably sufficient for ordinary users. More information and examples check
the "Allocating Disk Space" from the FreeBSD Handbook.

For more security, you can check the "Use Encrypted Swap Space" option, which will not leave any passwords or credit card
numbers visible in your swap space. Swap Space Encryption can also at a later stage be turned of or off with the Services
Manager.

Click "Next" to go to the next step:

System Components 
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On the system components screen one or more software packages can be selected for installation. In the "Available Components"
box the most common packages are listed, plus the FreeBSD ports directory and the FreeBSD source code. Selecting and
installing packages at this point saves you from downloading and installing them after the installation PC-BSD.

The following packages are available as components:

Firefox (Mozilla's popular web browser) - website

K3B (Powerful CD /DVD burning tool) - website

Educational Games (KDE Educational package) - website

Games (Arcade, Board, and Card games) - website

Office Suite (The KOffice Suite) - website

Software Development Kit (tools for writing software) - website

Desktop Toys (Misc programs for your desktop)

OpenOffice.org (Full featured office suite) - website

Opera (Web Browser with BitTorrent client) - website

Ports Tree (FreeBSD ports collection) - website 

Source Code (FreeBSD system source) - website

To be able to install any of these packages, you will need installation CD #2 (Multi-language support & Essential PBI Pack).

Ready to install
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At this point, you are about to copy all files from the CD-ROM to your hard disk drive.

Click "Next" to start the installation:

The system is now being installed. This process is quite fast. On a modern hard disk drive, it should take around 15 minutes. 

If you selected one or more components (in step 2.1.9) you will be prompted to insert installation CD #2:
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Setup Complete

At this point, you're done; The setup is now complete and PC-BSD is installed successfully on your computer. You can safely eject
the CD, and click "Finish" to reboot the computer. If you installed the PC-BSD bootloader, you will have to choose "FreeBSD" from
the list, in order to load PC-BSD. Otherwise, your computer should load PC-BSD directly without your intervention.

 

Starting up PC-BSD 

Boot up selection 
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PC-BSD shows a boot up menu with eight choices when starting up. Most of them are identical to the options shown during booting
up the PC-BSD Installation CD (see above; The Installation). However, instead of "Boot PC-BSD to emergency prompt", option 6 is
now "Run installer in VESA mode". This is the option to choose should you get a black screen or in case you have problems with
the screen resolution stopping you from using KDE.

Display Settings

After the installation, during the first startup, you have to select your desired screen resolution, color depth and the video driver. For
your monitor's native (or optimum) resolution and the colour resolution check the screen's documentation or the manufacturer's
website. The video card driver can be selected from the "video driver" dropdown list.

Optionally, the settings for the horizontal synchronisation and the vertical refresh can be set and adjusted on the "Advanced" tab.
To add the horizontal and vertical frequency, mark the "Monitor Settings" tickbox, and enter the details (which, again, can be found
in the monitor's documentation or the manufacturer's website).
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When you have entered and selected the different settings, click "Apply" for them to be saved and tested. If anything goes wrong
during testing, you will be taken back to this "Display Settings" screen, so you can amend the details. If you're happy with the
resolution, click "Yes" in the next step. Click "No" to return to the "Display Settings" screen.

Logon to PC-BSD 

After having set up the screen settings and the video card you can log in with the user account details as set up in step 2.1.7.
Optionally, you can adjust some session related settings at the bottom on the right.

If you marked the "Auto-login User" in step 2.1.7 then you won't see this login screen and PC-BSD will launch the KDE desktop
environment without prompt.

Either way, whether you logon manually or automatically, next you see the KDE splash screen:
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PC-BSD is now up and running. Welcome to the desktop.

 

2.4 Network configuration 

PC-BSD comes with an easy network configuration tool where you can set up your network and your network interfaces in no time.

There are two ways to configure your network interfaces:
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Either you don't mind using any IP address from your ISP or you don't know what your DNS servers are, in which case you 
will use the DHCP protocol (recommended)
Or you have a small network of two or more computers, and you want to assign a local IP address to each of them such as 
192.168.0.1, 192.168.0.2, etc... In which case you will need to know the DNS servers

To start configuring your network interface, click the Start Menu in the lower-left corner (red ball) and click "Settings > Internet &
Network > Network Settings". The main window will appear. Resize the window so that you can see the lower buttons:

As you can see, for security reasons, all options are greyed out. To edit the settings, you need to click the "Administrator Mode..."
button and type your administrator password at the prompt. Then you will be able to set up your network interface. To do so,
double-click one of the network interfaces listed in the main window. A popup window appears for you to adjust various settings:
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Select either "Automatic - DHCP" (Recommended) or "Manual", accordingly. If you selected "Manual", you need to type the
following information:

IP address: The IP address you want for the selected network interface. This IP address cannot be a public IP and needs to 
belong to private network IP addresses
Netmask: Can be set using numbers (ie: 255.255.255.0) or using hexadecimal values (ie: 0xffffff00)
Activate when the computer starts: This option should be checked if you want to use your network interface automatically 
when you start your computer
Description: Type a name to identify your network interface
Gateway: If you connect to the Internet through another computer, server or router, also known as "gateway", type its IP 
address

Click "OK", and repeat the procedure for other network interfaces if you have several that are to be used. If you have a gateway,
click the "Routes" tab where you should have your gateway listed and the network interface through which the route will go:
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If you selected "Manual" setup, click the "Domain Name System" tab to set up your DNS. This does not apply if you selected
"DHCP" for your network interface.
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Add at least one DNS here. It is advised that two DNS are set, so that you don't rely on just one. If you don't know your DNS, either
get in touch with the technical support of your ISP, or ask some one who lives in your geographical region and who is
"computer-savvy".

When you are done, click "OK" and your network interfaces are set up. You should be able to access the Internet and other
computers of your network if you have them. If you have a DSL connection that you need to dial from your computer manually or if
you use a dialup connection, please get in touch with us on the forum for more details to assist you.

Post-installation section will now help you test the water and customize your new operating system to your own taste.

 

2.5 Post-installation

As you will see, PC-BSD comes pretty much tailored with the common user in mind. Most will have little to change in PC-BSD's
configuration if any. There are still several things that some people like to change that we have listed here for you.

Graphics card configuration

You are asked to configure your graphics card right after installing PC-BSD. To find out what driver you should use, have a look at
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the list of common graphics cards and drivers.

Installing applications

Like popular commercial operating systems, PC-BSD makes software installation a breeze. The same way Microsoft Windows uses
a setup.exe or .msi file and Mac OS X uses setup.dmg, PC-BSD uses an executable setup file with a .pbi extension, standing
for PC-BSD Installer. As you will see later in this guide, to install applications, you follow 3 simple steps:

Search for an application on a .pbi web site such as the PBI Directory
Download the executable .pbi setup file onto your computer
Double-click the .pbi file and click "Next" all the way

It is this simple. Common software that people like to install are OpenOffice.org, the codecs (to play MP3 and video), or different
browsers such as Opera or Firefox.

Installing more fonts

It is easy to add more fonts in PC-BSD. There are two ways to install fonts:

Using a fonts .pbi file: Access a web site such as the PBI Directory, search for "fonts", download your .pbi file, 
double-click it and install the fonts. Log out from KDE and log back in. You should be able to use the new fonts 
Using regular TrueType font files: Download your .ttf files onto your desktop, then copy them to your hidden .fonts
directory. This can be achieved using the font installer as follows

Click the lower-left Start Menu (red ball) and click "Settings > System Administration > Font Installer". The Font Installer will show
up:

Click "Add Fonts", select your new fonts, and add them:
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When you are done, click "Ok". You will need to log out from KDE and to log back in for changes to take effect.

Windows users may feel more comfortable using the Microsoft fonts that can be accessed on the PBI Directory. After installing
these fonts, PC-BSD's fonts will look like MS Windows'.

Adobe Flash

The use of Adobe Flash is getting more and more prevalent on the web in ads, flash games, video sites etc.

Until now it has only been possible to play flash movies with proprietary software, but recently an interesting and much promising
project, Gnash (GNU Flash) has emerged. Gnash is an open-source Flash player able to play Adobe Flash animations and movies.

The two architectures for Flash that are being supported by Adobe are Windows and Linux. With no native FreeBSD version
available yet, the only way to see Flash web content on PC-BSD is by using Adobe's Flash Player for Linux.

Following the steps below, you should be able to set up Flash in the three mainstream browsers, Konqueror, Firefox and Opera.

 a) Konqueror

The easiest way to set up Flash support in Konqueror is by downloading the Flash plugin for Konqueror from the PBI Directory.
Running this PBI may take some time as it needs to download and install the plugin. Please be patient and wait until the installation
is confirmed.

In order to have Konqueror know that you have installed flash, you need to search for the new plugin. Go to: "Settings > Configure
Konqueror" and click the "Scan for New Plugins" button.

Note: It is recommended that you update your ports tree first (see Installing Software using Ports). Restart now
Konqueror and Flash should be working.
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b) Firefox

Adobe Flash is currently not working with the Firefox PBI (FreeBSD Firefox version), even if the Flash PBI for Konqueror is installed.
On many systems this Konqueror Flash PBI unfortunately makes the Firefox browser crash when it accesses a Flash containing
web page. Crashing can be avoided if the Firefox Flashblock Extension is installed.

If you need Flash, love Firefox and you're not afraid to "get your hands dirty", you can install the Linux version of Firefox that can
handle the native Flash plugin. To install Linux Firefox from the package repository, type as superuser in the command line:

You must have a Linux Compatiblity Layer installed on your system to install Firefox for Linux. (A Linux Compatibility layer is
simplistically explained a sort of layer that translates Linux system language into code PC-BSD understands)

Now install the Flash Plugin, by typing as super user:

Note: It is recommended that you update your ports tree first (see Chapter 4.1: Installing Software using Ports). In case your Firefox
font resolution is too big now, go to: "Edit > Preferences > Advanced > Display resolution" to decrease the resolution settings.

c) Opera

To have Flash working in Opera, it is recommended you install the Linux version of Opera from the Ports Tree. Type as super user:

Note: It is recommended that you update your ports tree first (see Chapter 4.1: Installing Software using Ports)

Java

The FreeBSD Foundation has a license with Sun Microsystems to distribute FreeBSD binaries for the Java Runtime Environment
(JRE) and Java Development Kit (JDK), which means it is also available for PC-BSD. Should you need Java for playing games,
doing online banking or anything else, download the Java PBI, install it and you're ready to use it.

Codecs

For license reasons we cannot ship multimedia codecs with PC-BSD. If we did ship codecs, you could watch movies out of the box,
but PC-BSD wouldn't be free of charge. Apple and Microsoft have paid for codecs and are therefore legally allowed to redistribute
them. Another reason why we cannot ship codecs is that this is illegal in some countries, e.g. the United States. It's not only the
governments' laws, but also the codec's group laws (ex. the MPEG group) that restrict the distribution of codecs.

There are a couple of media players available for PC-BSD (either as PBI or installed from ports), such as KMPlayer, Kaffeine, VLC,
and Xine. These media players let you play, together with the Codecs PBI, about 99% of .wmv, .avi, .qt, .asf, .asx, .ogm,
.mp3, .ogg, .m4a, .mpg, DivX/Crapola, Real Media files, and embedded media. Judging from feedback on the forums KMPlayer
(and to a lesser degree Kaffeine) seems to be the best player.

However, tastes and experiences are varied and many; some people can play (nearly) all media with KMPlayer, whereas others
have more success with Kaffeine and Xine. Just try and see what works best for you and if you get stuck please search the for a
solution.

Note 1: When you install the codecs (Win32, libdvdcss, libdvdread etc) from the ports, make sure you install the codecs before
installing any media player.

Note 2: A common problem with the Kaffeine Player is that it says it cannot see the codecs when one tries to play a DVD, but it
actually does. It looks for the codecs in /usr/lib but they are in /usr/local/lib. Just ignore the message and try reading a
DVD.

If you really want to get rid of the message, you can move the codecs to the /usr/local/lib/ folder by putting the following in
terminal (as root):

Close the terminal & re-run Kaffeine.

# pkg_add -r firefox

# portinstall linux-flashplugin

# cd /usr/ports/www/linux-opera/ && make install clean

# cd /usr/ports/www/linux-flashplugin7/ && make install clean

$ su -

# cp /usr/local/lib/codecs/libdvdcss* /usr/local/lib/
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Windows Software 

You may have been playing with the idea of migrating from Windows to PC-BSD. Not being able to then use some of your favourite
games or professional Windows applications (e.g. Adobe Dreamweaver), may hold you back from taking the plunge. Good news for
you: there are free and open-source solutions to get those programs running on PC-BSD. Please refer to this how-to in the PC-BSD
Knowledge Base if you're interested.

2.6 Troubleshooting

If you can't even start the graphical installer, when you are in the initial text installer screen, select 7 "Run installer in VESA mode":

Most of the times this is enough. If you can't even get this screen, this is probably due to a fatal trap 12 error. You first can unplug
as many devices as possible, for instance unplug webcams, scanners, printers, USB mice and keyboards, keep the bare minimum
hardware. If this solves the problem, start plugging more hardware little by little to see which one is causing the problem.

If this doesn't solve your problem, try disabling ACPI the next time you start up on the very first black & white screen. Additionally,
your download may have experienced a problem and PC-BSD's installation CD-ROM may be corrupted. To check integrity of your
.iso file, you can either use the md5 tool on Unix systems typing md5 <name_of_file> in your terminal or you can use
WinMd5Sum for MS Windows. You will find the md5 checksum on the download page of PC-BSD for each .iso file. For each of
them, the checksum reported by either md5 or WinMd5Sum must be the same as the checksum listed on PC-BSD's download
page.

More troubleshooting entries will be added on this page over time. Let's discover PC-BSD's workspace now.

3 Workspace

If you are familiar with MS Windows, you won't get lost with PC-BSD, and if you have already used KDE, you will feel right at home!
PC-BSD's workspace is an intuitive interface that follow common sense usability rules which you can find in other modern operating
systems, with a task bar at the bottom of the screen, a start button, which in this case is the red icon in the lower-left corner, also
known as the "Start menu", and your application shortcuts in the main screen:
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As you see, clicking the "Start Menu" toggles a list of options:

Most used applications

PC-BSD will list here the applications that you use more frequently. You can easily launch them from here and save time rather
than having to browse through the regular application menu.

All applications

In this list, you can find all applications that come with PC-BSD as well as software that you can install separately. Applications are
sorted by category (Games, Graphics, etc...). In the "PBI Programs" entry, you will see a list of PBI applications that you may have
installed. If no PBI application is installed, this entry will not be visible.

Find Files/Folders

This neat utility will help you retrieve files or directories either searching for part of its name or part of its content in the case of text
files. Click the "Contents" tab to search for files based on their content (ie: search for a file that contains "password"). You can use
wild cards such as "*" for a more sophisticated search:
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Help

If you are new to KDE (PC-BSD's desktop environment), you will probably find the KDE Help Center interesting and useful. It will
show you how to use all applications, menus and other utilities. The KDE Help Center offers a comprehensive manual to learn
everything a KDE user needs to know:
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Settings

In "Settings", you have access to the K Control Center, KDE's control panel. You can either access the K Control Center main
window or a sub-item of the control panel. The K Control Center is detailed later in this chapter.

System Menu

In the system menu you can access:

Your "Home" folder, where you store your personal files, such as music, video, or office documents.
"Storage media", where you will find your hard disk drives, USB flash key, floppy disk drive, DVD-RAM and CD-RW drives.
"Remote places" where you can connect to Windows shares and file servers using Samba.
The "Trash Can"
"User folders" to browse other people's directories on your computer

The "home" directory:
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Your media:

Your network drives and Windows shares:
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List of user folders:

Run Command

You can use the "Run Command" to run a single command such as kontact to launch the "Kontact" application, but you will
probably prefer using the terminal to run a series of commands. Clicking the "Run Command" pops up a window for you to type
your command:
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Session menu 

The lower menu allows you to:

Switch user: If some one wants to use your computer using his own username, you can switch user and retrieve your 
current session afterwards.
Lock session: If you wish to leave your computer for a while and if you want to disallow people from using it, just lock your 
session. Your screen will be password-protected with your user password. 
Log out: Click here to log out or to turn off your computer.

Now that you know a little bit more about the PC-BSD workspace, let's see what applications come with PC-BSD by default.

 

3.1 Applications

Rather than presenting a whole list of applications, let's discover the most common applications that you will use on a daily basis.

PC-BSD comes with full-featured quality and open-source applications developed for the KDE desktop. As we saw previously,
applications are organized into categories. This way you can find what you want easily and quickly.

Games

A number of quality games come with PC-BSD's default installation. The range of games includes: Arcade, board games, card
games, kids games, tactics & strategy. Let's click "Games > Arcade > KSirtet" for instance to launch a Tetris-like game. There's
nothing like a good old Tetris :)
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Graphics

Most software listed under "Graphics" are utilities that regular users are not going to use on a daily basis. KPDF, a PDF viewer can
be launched double-clicking a .pdf file for instance. Same goes for KView, an image viewer that you can launch double-clicking an
image file. If you want to take a screen shot of your system or of a single application, you can use KSnapshot. For image editing,
you will probably want a software application such as popular Adobe Photoshop or JASC Paint Shop PRO. These applications are
not available on PC-BSD yet, but you can install KOffice (from pbidir.com or from the 2nd installation CD), an office suite, and use
Krita, a good image editing application that comes with KOffice and that works very well on PC-BSD.

Internet

Several applications listed in this category are popular among users. First, Kmail, KDE's e-mail client offers all you may expect from
an e-mail application, it is light-weight, fast and has a similar interface to other popular e-mail clients:
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Konqueror is PC-BSD's default web browser. Konqueror uses the KHTML rendering engine, which means that pages you visit will
be rendered the same way as Apple's Safari web browser. If you search a little bit into Konqueror's menus, you will find the settings
that list a number of options that will please the most power users. You can open new tabs hitting "Ctrl-T". Konqueror has similar
options and interface to other web browsers:
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Most of us love instant messaging. If you do too, you will probably love the power and simplicity of Kopete, KDE's instant
messenger. Kopete is compatible with a number of services and protocols, including but not limited to: MSN Messenger, Google's
Gtalk, Jabber, Yahoo Messenger, ICQ, and AIM. Kopete's interface is uncluttered, minimal and, obviously, has no advertisements:
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Multimedia 

PC-BSD's multimedia applications allows you to watch your favorites movies and to listen to your music easily, like you would do on
any other system. KMix is PC-BSD's mixer to adjust volume:

You can turn everything up to 80% and you should have a clear sound with no saturation. The default multimedia player on
PC-BSD is called Kaffeine. Use Kaffeine to listen to audio CDs, audio files on your computer, streaming radios through the Internet.
Also use Kaffeine to watch DVDs, video CDs, videos on your computer, streaming videos on the Internet. Kaffeine is multi-purpose
and therefore you can use only Kaffeine to play all your media files if you want. Please note that most media is encoded using
proprietary codecs, this is the case for DVDs, audio files with the following extensions: .mp3, .wma; video files with the following
extensions: .avi, .wmv, .asf, .qt, .mpg, .mpeg. To play these files, you will need to download and install the essential codecs.
Kaffeine can play out of the box all free/open formats such as Ogg and Theora Vorbis. PC-BSD encourages everybody to use free,
open and patents-free formats whenever possible. Here's the Kaffeine multimedia player:
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Additionally, you can download Amarok, and award-winning jukebox for KDE.

Office

To manage your mail, your meetings, your contacts, your notes, your RSS feeds and your tasks, you will probably enjoy using
Kontact, KDE's Personal Information Manager:
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Kontact offers the functionality you need in a light-weight application. As you can see, Kontact is a bundle of office applications that
can be used separately.

Manage your contacts with KAddressBook. They will be available in other Kontact applications such as KMail. KAddressBook is
easy to use and offers advanced search features such as filters to manage large lists of contacts. Its interface is straight-forward
and you will be able to use it in no time:
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Manage your meetings with KOrganizer. You can easily add new events and edit them. With the calendar in the upper-left corner,
you can select the day you want to view events accordingly:

As a side note, you can download the office suite of your choice. We recommend either OpenOffice.org or KOffice. Both of them
are compatible with the recommended .odt OpenDocument file format. OpenOffice.org is full-featured and renders Microsoft Office
documents very well while KOffice is light-weight.
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PBI Programs

In the "PBI Programs" menu, you will find the list of PBI applications that you installed. If you haven't installed any PBI application,
this menu will not be listed.

System

Advanced usage of PC-BSD usually assumes that you use the terminal, also known as CLI (Command Line Interpreter). The
terminal allows you to interact directly with the core of your system by entering commands. The terminal interface is a simple
window similar to the MS-DOS window in MS Windows:

To execute a line of code, just type it and hit "Enter". It is sometimes important to know disk space usage on your hard disk drive.
KDiskFree is a neat application with a nice interface that will show your disk usage on all your partitions. You can see the amount of
disk space used and the percentage:

Utilities

Ever wondered if PC-BSD had a graphical calculator? Well yes, it does, PC-BSD has a nice calculator, KCalc, that can be switched
to "Scientific" mode or "Simple" mode:
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Now, what would you use to edit text files, or to develop a script with code highlighting? Kate is KDE's most advanced text editor
with a document selector in the left pane:

If you want a more simple text editor, you can use KEdit or KWrite as well. They provide simple text editing. These text editors are
compatible with the universal utf-8 file format that allows to type in any character available in any language on the planet such as
Tamil, Armenian, Arabic or Korean in the same document.

These are the most commonly used applications on PC-BSD. PC-BSD doesn't come with many applications and leaves you the
choice to install the ones you feel more comfortable with. Fortunately, as you will see, installing new applications in PC-BSD is very
easy. You won't have to learn how to use a package manager or to type commands in the terminal.

Now that we have a better idea of the default applications that ship with PC-BSD, let's see what options we have in the K Control
Center, PC-BSD's control panel.

 

3.2 K Control Center 

To launch the K Control Center, click "Start Menu > Settings > Control Center". PC-BSD's control panel is based on KDE's K
Control Center, an interface with several categories related to system management in the left pane:
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Going through each of these categories with all possible options would be tedious. Let's rather discuss the most common settings
that you may find useful! In the left pane, click the following categories to toggle the lower options.

Appearance & Themes

Background: Change the desktop background to your taste. You can even choose a plain color instead of an image
Colors: Create your own color scheme for all widgets, scroll bars, backgrounds, buttons and text. You can save and import 
your color scheme
Fonts: Define font families and sizes for several elements of your desktop
Screen saver: Enable/disable the screen saver. You can also choose which screen saver you want to use, if you wish to use
one
Style & Theme Manager: Change the look and feel of your desktop

If you are interested in changing the look-and-feel of PC-BSD, KDE-look.org is a useful place to go to. You can find here many
other theme's, window decorations, cursors, skins, screensavers etc etc and explanations how to install them.

Desktop

The "Desktop" section allows you to arrange elements of your desktop, such as the position of taskbars, number of virtual desktop
and other minor options.

Internet & Network

The "Internet & Network" section lists a number of network utilities that will be discussed later in this guide.

KDE Components

The KDE components allows you to associate file extensions to applications, to define default applications for common services
(Web browsing, IM, E-mailing)

Peripherals

You will find a device overview to see what is present on your computer. In this section, you can also adjust your monitor, keyboard
and mouse settings.
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Regional & Accessibility

Adjust regional settings, select language, change keyboard layout and shortcuts, as well as default regional values such as
monetary symbol and numeric delimiters.

Security & Privacy

Manage users and passwords.

Sound & Multimedia

Adjust codec options, audio CD settings. Choose and change system sound and bells.

System Administration

Adjust date and time, install fonts, adjust login screen, manage online updates, remove PBI files.

Let's see now the common tasks to learn how to install applications, how to add new users, custom fonts, and how to download
system updates on your system.

4 Common tasks

In this chapter we will go over a number of common tasks faced by every day users and administrators. We will discuss such
matters using plain English and describe it using illustrations of the graphical user interfaces, the command line interfaces, as well
as configuration files. This will allow you to chose which method you prefer to be more productive.

We have broken down common tasks into the following:

Installing applications
Adding new users
Downloading system updates

4.1 Installing Applications

There are several methods of installing software on a PC-BSD system. Each method will be described in more detail below.

PBI Installer, the easy way (recommended) 
Packages, the quick FreeBSD way
Ports, the traditional FreeBSD way

When you install software from a PBI you will be presented with a simple graphical interface which takes you through the steps to
install your software. Similar to many other popular operating systems you just click and go. Since PBI programs are created from
traditional FreeBSD ports and packages, they are fewer and less up to date than ports.

Ports and Packages are the traditional ways of installing software.

You can get the most up to date software by compiling directly from ports. The quicker method of installation is by package, but not
all software is available as a package.

Installing software via PBI

When you install a program through the PcBsdInstaller system it is placed with all required files in its own folder in /Programs and
linked into the system. This is very simple and safe to the system as it is not changed more than necessary to allow the software to
function.

To install a PBI we need to go to the PBI Directory and download a program:
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Once the download is completed, simply double click on the file to launch the installer. It will prompt you once for the super user
password before beginning the installation process. This is effective as a security measure, parental control, and prevents
accidental alteration of the system.

Click "Next" at the welcome screen, you will then be asked to read any license agreements that comes with the program you are
installing. Check the "I agree" box and click "Next" to continue installation. You may have the options of placing icons on your
desktop and entries in the PBI Programs section of the application menu. Check all boxes that apply and click "Install":

Once the installation has completed, click “Finished” and try out your program.

You can also install in text mode from a console session by changing directory to the location of the PBI and run the following as
the super user.

# ./PBI_File -text pbifilename-1.0-PV1.pbi
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If at a later date you wish to add an icon to your desktop for software installed during a PBI install you may do so by right clicking on
the desktop and selecting "Create new link to application". This will open a menu where you can set the name of the icon, its picture
(click the cog image). Then click the "Application" tab. Here you will have to set the program you wish to create an icon for, you can
set a comment, description, the work path, and file types as required.

Removing PBI applications

To remove a .pbi application, just go to "Start Menu > Settings > System Administration > Remove Programs (PBIs)". You will see
the list of installed PBI applications:

Click the application you want to remove and press the "Remove" button in the lower-left corner. When you are done, click "OK".

Installing packages

Packages are prepared files for installing software, they install software into the system and can cause dependency issues. The
package system is comparable to yum, and apt-get used in several Linux distributions. To find the name of a package, first you
need to search on the FreeBSD ports database. For instance if we want to install Skype, we search for "skype" and we find 2
search results: the development release and the stable release. If you pass your mouse over the name of the package of the stable
release, you see something like http://cvsweb.freebsd.org/ports/net/skype in the status bar of your browser. The
/net/skype part tells you that the name of the package is skype and that it belongs to the net category. You don't have to
download anything, as the package manager will take care of that for you. Just remember the name of the package. Installing
packages requires you to open a console with root permissions. You can type kdesu konsole in a run dialog from the K-Menu or
open a konsole from the K-Menu in super user mode, or open a konsole and type su - and press "Enter". You will be prompted for
the root (super user) password, it will not display the password on screen for security reasons. After switching to the super user
account you have complete access to the system and can install software at will. You can install a program using the package
system thusly:

This will install the "irssi" program with all required files but not update the K-Menu or desktop. You can generally find the binary
(executable) in /usr/local/bin, configuration files in /usr/local/share/ or your home directory and the libraries (like .dll) will be placed
into the system as needed and shared between applications.

You can uninstall a package by using the pkg_delete command and the name and version of the package or a wild card.

You can get info about an installed package the same way using the pkg_info command.

# pkg_add -r irssi

# pkg_delete  irssi-0.8.10_2            # And pkg_delete "irssi-*" are equivalent.

# pkg_info "irssi-*"            # Or pkg_info | grep irssi
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Installing software using ports

Traditionally BSD installs software from source; the ports collection. You first need to install an up to date ports collection before
you may use the ports collection to install software. New users coming from Gentoo GNU/Linux will find this similar to the “Emerge”
system which is based on FreeBSD ports.

To install the ports collection click on the K-Menu and navigate to: "Settings > Administration > PC-BSD System". Enter the super
users password to access the admin panel and click on the "Tasks" tab. Now click "Fetch ports" and it will begin downloading the
necessary files and installing them. This will take a while depending on your Internet connection and Processor speeds.

If you wish to do this from the command line open a console as the super user as described in fetching packages and run the
following command:

You can also use the portsnap method

If you install ports using portsnap you should not update the ports collection with cvsup, instead use:

if you installed ports using cvsup you may update them in the same way as before:

You can edit the supfiles and set a download mirror closer to you, please see the FreeBSD handbook for more information on using
CVSUP.

Now that the ports collection is installed if you look in /usr/ports you will see a simple tree structure of folders. The structure is in
the format of category > program name.

Then, to install an application from ports, just go to the application directory, for instance /usr/ports/net/skype and start compilation:

# cvsup -g -L 1 /root/ports-supfile

# portsnap fetch extract

# portsnap  fetch && portsnap update

# cvsup -g  -L 1 /root/ports-supfile
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After a few minutes or hours, depending on the size of the package, the application is installed on your system.

Removing a package or a port

To remove a package or port, first you need to find the name of the package. For instance if you want to remove kopete, to find out
its full name, you will type:

Then to uninstall the package, type as root:

If you installed from the ports, you can also uninstall going to the specific port directory and you can uninstall from there:

To learn more about ports and packages, feel free to read the excellent FreeBSD handbook. Let's see how we can add users in
PC-BSD now.

4.2 Adding new users

The two ways to add a new user to your system is by using the "User Manager" program or the adduser script. User manager is a
graphical program and easy to use with the mouse. adduser is a very flexible command line method.

Open the Start Menu and go to "Settings > Security & Privacy > User Manager". Here you can add, remove, and lock users, change
the super users (system) password. To add a new user you will need to have a user name and password, you may also input the
full name of the user for reference.

# cd /usr/ports/net/skype

# make install clean

# pkg_info | grep kopete

kdenetwork-kopete-0.11_1 KDE multi-protocol instant messenger (IM)

# pkg_delete kdenetwork-kopete-0.11_1

# cd /usr/ports/net-im/kopete

# make deinstall
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To add a new user with adduser open a konsole in super user mode and run adduser. Here is an example of running the
adduser script, the options listed in side brackets are the default used when merely pressing "Enter" to continue:

Here we have added a new user named "john" to the groups wheel and operator giving him greater access to hardware and the
ability to switch user to root, that is run programs as the super user. The choice of shells include the Bourne Shell (sh), C Shell
(csh) and the Bourne Again Shell (bash). More shells can be installed using PBI, Ports, or Packages. You should only add users to
the wheel or operator groups that you want to have administrator access to the machine. Some one who you do not want to have
the ability to switch to the super user should not be in the wheel group!

# adduser

Username: john

Full name: John Smith

Uid (Leave empty for default):

Login group [john]: wheel

Login group is wheel. Invite john into other groups? []: operator

Login class [default]:

Shell (sh csh tcsh bash nologin) [sh]: bash

Home directory [/home/john]:

Use password-based authentication? [yes]: yes

Use an empty password? (yes/no) [no]: no

Use a random password? (yes/no) [no]: no

Enter password:

Enter password again:

Lock out the account after creation? [no]: no

Username   : john

Password   : *****

Full Name  : John Smith

Uid        : 1002

Class      :

Groups     : wheel operator

Home       : /home/john

Shell      : /usr/local/bin/bash

Locked     : no

OK? (yes/no):
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An example of someone you would give the super user password to, and give wheel membership, is someone you trust to be able
to add programs and hardware to the system. An example of someone who should not be in the wheel group is a child you may
not want to be able to modify important files, or install software.

 

4.3 Downloading system updates

Updating a PC-BSD system is a very simple process. PC-BSD is updated in a similar matter to installing software using PBI. You
can check if your system is up to date by running the System Updater utility

he Update Manager helps you to keep PC-BSD up-to-date by downloading and installing the latest patches and updates.

While starting up, PC-BSD checks by default if any updates are available (internet connection is required). The Updater icon in the
system tray (right hand bottom of the screen next to the clock) shows whether your system is up-to-date or not.

There are four different states of the Updater system tray icon:

Your system is up-to-date 

System update(s) and patche(s) available to be downloaded and installed 

Looking for updates and patches 

Selected updates and patches are being installed

There are different ways to launch the Update Manager:

by clicking the PC-BSD Start button -> Settings -> Software & Updates -> Online Update Manager, or 
by double-clicking on the Updater icon in the system tray or by right clicking it and selecting "start the Update Manager" 

 

The Update Manager has three tabs:

System Updates
PBI Updates
Configuration

Let's have a look at them individually.

System Updates
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Click to magnify

This screen is divided into two sides. On the left hand side are any available updates listed. These can all be selected at once by
clicking the “Select All” button or by selecting them manually. On the right hand side you see the “Check for Updates” button which,
when clicked, will connect to the update server to check if any updates are available.

If any updates are found, a pop up "System updates are available" comes up, and the updates are shown in the “available updates”
pane.

Though the installation of updates is highly recommended as they make your system more secure, add more functionalities and fix
bugs, these updates are not mandatory; you’re free to download and install (a selection of) them. Oh, and you don't have to verify if
you have a valid PC-BSD license ;-)

Selected updates will be downloaded and installed when the “Install selected updates” button is clicked:

To view the progress of the downloading and installation, double-click the Updater icon in the system tray which will then bring up a
screen similar to this one:
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When the installation of the update(s) is successfully completed, the Installer will notify you of this:

If a reboot is required the following dialog screen comes up. Clicking the OK button won't reboot the PC automatically, so you can
finish whatever you're doing and reboot the computer at a convenient time:

PBI Updates 
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Click to magnify

The second tab window, PBI Updates, is identical to the System Updates tab, but with one difference: instead of looking for updates
for the PC-BSD operating system, the Updater will check if there are newer PBIs listed on pbidir.com to those that are installed on
your PC already. For instance, if you have installed Firefox 2.0.0.11 and version 2.0.0.12 has been added to the pbidir.com website
later, the Updater will list version 2.0.0.12. The older version can then by removed and the latest installed.

Configuration

Click to magnify

The Configuration tab has tree options which are all activated by default in order to check for system and PBI updates at system
bootup.

Downloading and installing of system updates are highly recommended in order to keep your system safe and free of bugs. By
default the Updater will also check if any newer and more up-to-date versions have been added to pbidir.com after you installed a
particular PBI.

The last option on the Configuration panel is "Run the System Updater at startup". PC-BSD checks by default if any updates are
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available on PC-BSD's update server. If, for any reason, you deem this not necessary, this option can be turned off.

DO NOT cancel the update while a patch is running, restart the computer or otherwise disrupt or interrupt the update
even if it appears to be stalled. An update can take some time to complete. You will be notified when the update has
been completed and be asked to reboot for all changes to take effect.

5 System

The PC-BSD desktop allows users the ability to find nearly anything you would ever want to know about your system. PC-BSD is
built on FreeBSD so users can always use the command line in a terminal to see system information but what is the fun of that? In
PC-BSD/KDE there are specific desktop programs to do this job for you using a graphical interface.

5.1 System Information 

Unique to PC-BSD there is a "System" window that can be opened by clicking on the "Start Menu> Settings > System
Administration > PC-BSD System". At this point a kdesu (the KDE super user shell) window will open and you will have to type in
your root password to allow the System window to open. Once the PC-BSD System window opens you will be presented with four
tabs with the following titles:

General
Kernel
System
Tasks

The General Tab

The "General" tab shows us the versions of both PC-BSD and the base FreeBSD system. It's a good idea to report both of these
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when asking questions on the PC-BSD forums or any of the FreeBSD lists.

Also found on this tab is a report generator that creates a report by clicking on the "Generate" button. While this report doesn't show
all system attributes, it does hold an abundance of pertinent information. Items included in the report are as follows:

the kernel responses as your system boots (dmesg)
the last few lines of the /var/log/ messages log file
your resource configuration file (/etc/rc.conf)
your boot configuration file (/boot/loader.conf)
the free space of your hard drive (df -m)
a listing of top (currently running processes)

You will be given an opportunity to save the generated report to a file and directory of your choice. Once it is saved it will open up in
kwrite (or your default KDE editor) for your inspection. While this report isn't a complete report of every variable of your system, it
is a very comprehensive report of most things that matter and it is quite lengthy. All successful probes and loads as well as most
errors will be reported here.

The Kernel Tab

Here on the "Kernel" tab you are presented with several options. They are:

the ability to select single or multiple processor kernels
enable/disable the splash screen as PC-BSD starts
enable/disable ATAPI DMA Mode
Boot Delay

Please be VERY CAREFUL setting options on this tab. The kernel settings and the ATAPI DMA can leave your system in
an unstable state if set incorrectly.
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If you have two physical CPU sockets on your motherboard, an AMD x2, an Intel Hyperthreading CPU with hyperthreading turned
on in the BIOS, or an Intel Core 2 then you should be safe choosing the Multi Processor kernel option by clicking on its drop down
and selecting it.

If you want to see all of the probes and peeks of PC-BSD/FreeBSD as it loads the operating system you can un-check the "Enable
Splash Screen" option and you will see all the raw messages as the system loads. Some people like to see what is happening and
this often comes in handy while diagnosing problems.

The "ATAPI DMA" option will probably not cause any problems if you turn it off but it may slow down your disk access. There seems
to be some computers with mostly older CD-ROMs or hard drives that may benefit by having this turned off.

The last option, the "Boot Delay", can be set anywhere from Off to 0 to 60 seconds. It defaults to 1 but some people prefer to set it
higher if they are diagnosing problems or need to boot up with special flags set.

Any changes on this tab must be saved by clicking on the "Save Changes" button.

The Services Tab

There are many services that can be enabled/disabled on this tab. The list is as follows:

Enable SSH support (Secure Socket Shell)
Enable NFS support (Network File System)
Enable Samba server (SaMBa - Windows File Sharing)
Enable CUPS server (Common Unix Printing System)

SSH support is enabled by default. If you want to log in from a remote terminal or use a remote desktop like noMachine's client
desktop then you must leave it enabled. For the paranoid, PC-BSD comes loaded and turned up with the denyhosts daemon
which will keep SSH attacks to a minimum. When there are several invalid SSH logins then denyhosts will ban the attacking IP
and the attacker is not allowed any further tries. This protection works very well and sends a report to the root on the daily security
run if any attempted break-ins are found. Do yourself and the world a favor, don't use common words as passwords.

NFS support is not turned on as default. If you intend to mount files from any other networked computers that have NFS available



PC-BSD Quick Guide file:///E:/Documents%20and%20Settings/Owner/Desktop/PC-BSD%20Q...

69 of 73 4/12/2008 2:23 PM

you will need to enable this feature.

Samba is on automatically and it used to share files with any Windows computers you may have in your network. If you don't have a
network or wish not to use this then you can safely disable Samba and save some system resources.

The CUPS server allows you to install printers and share them over your network. There are two different interfaces you can use to
set up your printer. One can be found by clicking on "KMenu > Settings > Control Center". Once the Control Center opens click on
the plus (+) next to Peripherals and then the Printers options. You should be able to set up a printer here but there have been
problems with some versions of CUPS and also some bugs in KDE that may prevent it from working properly. Many find that using
the second method, opening a browser, going to the address "localhost:631" and using the web interface is just as easy and works
much better.

As on the previous tab, any changes must be saved by clicking on the "Save Changes" button.

The Tasks Tab

This tab could also be called the "Wait" tab because if you run both of the functions on this tab you will be waiting, and waiting and
if you are on dial up connection you could be waiting several hours. The longest wait is only for the first time they are run, major
base updates or long intervals between updates. Like all good things that teach patience, this wait will reward you richly if you ever
need to compile a kernel or any application not yet available as a PBI. The two functions are:

Fetch System Source
Fetch Ports

The first function, the Fetch System Source, will open a small terminal screen and show you how it progresses. This will take some
time the first run or at long intervals between updating. If you run it on a regular basis that time will be greatly shortened.

The second function, Fetch Ports, will open a progress window and show you its progress as it downloads, expands and places the
ports tree under the /usr/ports directory. This one will also take a while to complete if you are using it for the first time or a long
period has elapsed between updates. Once your port tree is downloaded and in place you will be able to open a terminal screen
(konsole), log in as root, change directory to the application you want to install and run a make install clean to compile and
create the application you wish.
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6 Advanced usage

There are tasks that you will probably do only once in a while; adding hardware, sharing your connection to the Internet with others,
and configuring your firewall.

Such tasks are not complicated but they still involve typing a few commands and dealing with text-based configuration files.

Let's see how we can add hardware on a PC-BSD system.

6.1 Adding Hardware

When you add hardware on PC-BSD, you are faced with one of the following situations:

Your new hardware works out of the box and you need to install no driver. This happens to all top-end hardware and to 
quality hardware in general.
PC-BSD doesn't detect your new hardware or doesn't even start. This happens to some cheap hardware and there's nothing
you can do about it, unless you can write device drivers.

As you now know, PC-BSD is based on FreeBSD. The FreeBSD team has created an exhaustive list of compatible hardware. So
your best option before buying hardware is having a look at this list, especially if you want to buy some exotic hardware such as the
cheapest on-board motherboard of the store or a cheap TV card.

The hardware that works out of the box is as follows:

Virtually all CPUs
Virtually all RAM modules
Virtually all sound boards
Virtually all monitors
Virtually all IDE, SATA, SCSI hard disk drives
Mainstream USB Flash drives
Mainstream mice and trackballs 
Mainstream keyboards
Most graphics cards
Most motherboards

There is some types of hardware that are known not to work; winprinters and winmodems. These are devices built only for MS
Windows and rely on custom Windows software to handle much of their basic function. Thus, they are cheaper but will only work on
Windows. So beware! If you want to buy hardware and are unsure whether the model you are interested in is compatible with
PC-BSD, ask us on our forum first, we will be happy to help.

Now, let's see how you can share your connection to the Internet.

6.2 Internet Connection Sharing (NAT)

If you have more than one computer and if you use PC-BSD to connect to the Internet, you can share this connection with the rest
of your network. You are using your PC-BSD machine as a "gateway". To do so, you need a fixed IP address for your network
interface. If you don't yet, please have a look at the Network configuration to do so.

Setting up your computers 

Now, on your PC-BSD computer, open your terminal and type the following command:

Hit "Enter". It will ask your root password, type it and hit "Enter" one more time. The kwrite editor will open the rc.conf file for
you. In this configuration file, add the following line:

Save your file and exit the text editor. Restart PC-BSD, it should act as a gateway for other computers. To complete this process,
for each other computer, open the configuration of network interfaces. In the "Gateway" field, type the IP address of your PC-BSD
gateway, add also DNS entries. Now let's see if everything works.

Testing your environment 

We are going to do three tests:

$ kdesu kwrite /etc/rc.conf 

gateway_enable="YES"
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Graphics Card Device Name

3Dfx video driver tdfx

Alliance ProMotion video driver apm

ATI RADEON video driver radeon

ATI Rage 128 video driver r128

BW2 video driver sunbw2

CG14 video driver suncg14

CG3 video driver suncg3

Chips and Technologies video driver chips

Cirrus Logic video driver cirrus

Cyrix video driver cyrix

1. Access the gateway using the following command: ping -c 3 gateway_ip_address_here
2. Access the Internet without DNS using the following command: ping -c 3 4.2.2.2
3. Access the Internet using the following command: ping -c 3 google.com

From your PC-BSD gateway, try test #1 to make sure you know the IP address of your gateway. The output on your terminal
shouldn't give any error message:

If you get an error message, this is because your didn't set your fixed IP address properly. If so, please have a look at Network
configuration to set a fixed IP address for your network interface.

Now, do test #2. If the test fails, make sure you are connected to the Internet. It really should work if your connection is up. Do test
#3 which should work as well. If it doesn't, but if test #2 does, then you have a DNS issue. Please make sure your DNS are properly
configured on your network interface. The Network configuration chapter will assist you doing so.

Now, for each other computer of your network, let's try the following: Do test #1. If it fails, make sure the computer and the gateway
are properly connected. Then, try test #2. If it fails, make sure your gateway is properly configured to act as a gateway, as detailed
above. And eventually, try test #3. If it fails, you have a DNS misconfiguration on your computer. Make sure its DNS configuration is
the same as the gateway's.

Once all these tests succeed, your other computers can access the Internet using your PC-BSD machine. Now, let's configure your
firewall.

6.3 Firewall configuration 

PC-BSD uses OpenBSD's PF (Packet Filter) tool to filter incoming and outgoing traffic through network interfaces. Configuring the
firewall requires learning the basics of PF. To change the rules of your firewall, you need to edit the configuration file of the firewall.
In your terminal, issue the following command:

At the prompt, type your root password. A text editor will display the firewall configuration file. Make your changes and save. Reboot
PC-BSD. PF should use your new set of rules.

7 Appendices

Several topics are too important to be discussed in the quick guide so we included them in the end of the guide as a reference. The
first appendice is the list of common graphics cards and drivers.

7.1 List of common graphics cards and drivers

When you first boot PC-BSD you're asked to configure your graphics card. You have to choose which driver to use. If you don't
know yet what driver to use, here's the list of the most common graphics cards and drivers:

 

 

 

%ping -c 3 192.168.0.1

PING 192.168.0.1 (192.168.0.1): 56 data bytes

64 bytes from 192.168.0.1: icmp_seq=0 ttl=246 time=0.041 ms

64 bytes from 192.168.0.1: icmp_seq=1 ttl=246 time=0.041 ms

64 bytes from 192.168.0.1: icmp_seq=2 ttl=246 time=0.041 ms

--- 192.168.0.1 ping statistics ---

3 packets transmitted, 3 packets received, 0% packet loss

$ kdesu kwrite /etc/rc.d/pf_rules
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Glide video driver glide

GLINT/Permedia video driver glint

GX/Turbo GX video driver suncg6

Intel 8xx integrated graphics chipsets i810

Intel i740 video driver i740

Leo video driver sunleo

Matrox video driver mga

Neomagic video driver neomagic

Newport video driver newport

Nsc video driver nsc

Number 9 I128 video driver i128

NVIDIA default video driver (2D) nv

NVIDIA GeForce2 MX/MX 400
NVIDIA GeForce2 MX 100/200 
NVIDIA GeForce2 Go 
NVIDIA Quadro2 MXR/EX/Go 
NVIDIA GeForce4 MX 460 
NVIDIA GeForce4 MX 440 
NVIDIA GeForce4 MX 420 
NVIDIA GeForce4 MX 440-SE 
NVIDIA GeForce4 440 Go 
NVIDIA GeForce4 420 Go 
NVIDIA GeForce4 420 Go 32M 
NVIDIA GeForce4 460 Go 
NVIDIA Quadro4 550 XGL 
NVIDIA GeForce4 440 Go 64M 
NVIDIA Quadro NVS 
NVIDIA Quadro4 500 GoGL 
NVIDIA GeForce4 410 Go 16M 
NVIDIA GeForce4 MX 440 with AGP8X 
NVIDIA GeForce4 MX 440SE with AGP8X 
NVIDIA GeForce4 MX 420 with AGP8X 
NVIDIA GeForce4 MX 4000 
NVIDIA Quadro4 580 XGL 
NVIDIA Quadro NVS 280 SD 
NVIDIA Quadro4 380 XGL 
NVIDIA Quadro NVS 50 PCI 
NVIDIA GeForce2 Integrated GPU 
NVIDIA GeForce4 MX Integrated GPU 
NVIDIA GeForce3 
NVIDIA GeForce3 Ti 200 
NVIDIA GeForce3 Ti 500 
NVIDIA Quadro DCC 
NVIDIA GeForce4 Ti 4600 
NVIDIA GeForce4 Ti 4400 
NVIDIA GeForce4 Ti 4200 
NVIDIA Quadro4 900 XGL 
NVIDIA Quadro4 750 XGL 
NVIDIA Quadro4 700 XGL 
NVIDIA GeForce4 Ti 4800 
NVIDIA GeForce4 Ti 4200 with AGP8X 
NVIDIA GeForce4 Ti 4800 SE 
NVIDIA GeForce4 4200 Go 
NVIDIA Quadro4 980 XGL 
NVIDIA Quadro4 780 XGL 
NVIDIA Quadro4 700 GoGL

1.0-96xx

NVIDIA RIVA TNT
NVIDIA RIVA TNT2/TNT2 Pro
NVIDIA RIVA TNT2 Ultra
NVIDIA Vanta/Vanta LT
NVIDIA RIVA TNT2 Model 64/Model 64 Pro
NVIDIA Aladdin TNT2
NVIDIA GeForce 256
NVIDIA GeForce DDR
NVIDIA Quadro
NVIDIA GeForce2 GTS/GeForce2 Pro

1.0-71xx
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NVIDIA GeForce2 Ti
NVIDIA GeForce2 Ultra
NVIDIA Quadro2 Pro

Rendition video driver rendition

S3 Savage video driver savage

S3 ViRGE video driver s3virge

Silicon Motion video driver siliconmotion

SiS and XGI video driver sis

SiS USB video driver sisusb

SUNFFB video driver sunffb

TCX video driver suntcx

Trident video driver trident

Tseng Labs video driver tseng

VESA (Generic video driver) vesa

VGA (Generic video driver) vga

VIA unichrome graphics driver via

VMware SVGA video driver vmware


